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56 Chapter 3 Setting Up a Project Document

Supplying Information for a New Project
Setting up a new Project document correctly from the beginning will help make your use of
Microsoft Project 2003 much easier. Before you enter the first task in a new project, it’s a
good idea to examine several settings and make any required changes to them. Although
there are no defined rules for doing this, by following the steps outlined in this chapter, you
will be able to create a more accurately calculated schedule.

You generally use most of the default settings in Microsoft Project 2003 to schedule tasks.
Microsoft Project 2003 also allows flexibility and adaptability to accurately reflect the actual
workings of each individual project. You can change many of these settings after tasks and
resources have already been entered into the project. However, by addressing these issues up
front, you are guaranteed to create a schedule that is based on logic and calculated reason.

3
N O T E

Although you can address the preliminaries of a project in any order, the order in which
the topics are presented in this chapter is the order recommended when you begin
developing your first project.

You should understand the working conditions in a project, including the working calendar
and holidays, before attempting to set up the project. Microsoft Project 2003 calculates the
schedule for activities based on this information, so you should outline this information
before you begin using Microsoft Project 2003 to schedule tasks.

When you begin working with Microsoft Project 2003, you typically start by setting up the
environmental working options. Next, you define the working time calendar, considering
working hours and nonworking time. After you set up a calendar, you might want to print it
for review at a later time. You might also want to use the same calendar for other projects;
to do this, you need to use the Organizer, which is described later in this chapter (see the
section titled “Working with the Organizer,” or you could also use a template upon which
to base new projects.

Microsoft Project 2003 includes two wizards to assist in the process of setting up your pro-
ject: the New Project Wizard and the Calendar Wizard. Using wizards in Microsoft prod-
ucts makes the setup process easy and complete. You are strongly encouraged to take
advantage of these new wizards to expedite your setup time and allow you to focus on defin-
ing the scope of work for the project.

When you start a new project, you must consider whether you want the project to be sched-
uled from a specific start date or scheduled backward from a predetermined finish date. It is
not possible to do both. When Microsoft Project 2003 calculates the forward-scheduling of
tasks, it considers many factors, including the duration of the tasks, the base calendar
selected, the settings set by the user, dependencies defined between activities, the calendar
of the resource assigned, and, if one is created, a specific task calendar that is assigned to the
activity. When Microsoft Project 2003 calculates the backward-scheduling of tasks, it does
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57Supplying Information for a New project

essentially the same thing it does when forward-scheduling, except that it calculates back-
ward from the project’s fixed end date.

In addition to calendar information, you need to provide summary information; Microsoft
Project 2003 inserts this information into many of the reports it can generate, and this
information enables Microsoft Project 2003 users to search for specific contents of files
saved on your computer. You enter this summary information into the Properties dialog box,
which you access by selecting File, Properties. The following sections describe how you
input data into the Project Information and Properties dialog boxes.

Using the Project Information Dialog Box
To start a new file, choose File, New or click the New button on the Standard toolbar.
Microsoft Project 2003 now displays the options available to you in a sidepane called “New
Project.” You then need to select whether you want to create a new project from a template
or start a blank project. Selecting Blank Project automatically initiates the Project Guide to
guide you through the process of creating a new project. The pane now displayed is the
Tasks Pane, which is part of the default Project Guide. Each option is designed for you to
select each option in turn and be “guided” through the process of creating your new project.

Selecting Define the Project, for example, allows you to enter the start date of your project
without ever having to manually select commands from the menu.

➔ After each option has been invoked in the Tasks Pane, the Project Guide will allow you to move on to
other aspects of project creation. After you have worked your way through each section of the guide,
you will have created your project plan. The Project Guide makes the whole process intuitive and easy
for novice users to get up and running quickly with Microsoft Project 2003. For more information on the
Project Guide, see the section titled “Using the New Project Wizard” on p. 85. 

Of course, if you are a more experienced user you may prefer to simply access the Project
Information dialog box. 

You use the Project Information dialog box to record basic information about a project, such
as the project start date and the base calendar to use for scheduling. To access the Project
Information dialog box at any time, you choose Project, Project Information.

Figure 3.1 shows the Project Information dialog box that appears in the Standard edition of
Microsoft Project 2003. Figure 3.2 shows the Project Information dialog box that appears in
the Professional edition of Microsoft Project 2003.

3

Figure 3.1
The Project
Information dialog
box defines the start
date for a project.
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58 Chapter 3 Setting Up a Project Document

3

Figure 3.2
The option to have
the Project
Information dialog
box appear when you
open a new project is
available under the
General tab of the
Options dialog box.

Figure 3.3
The start date of the
project should be
defined from within
the Project
Information dialog
box, not the start field
of the first task of the
project.

T I P
If the Project Information dialog box does not display when you open a new project,
choose Tools, Options. On the General tab, mark the Prompt for Project Info for New
Projects check box. Then start a new file; the Project Information dialog box should now
appear (see Figure 3.3).

The fields in the Project Information dialog box are as follows:

■ Start Date, Finish Date, and Schedule From—The Schedule From drop-down selects
whether the project forward-schedules from a start date or backward-schedules from a
finish date. To define a specific date for a project to start, you can type the date in the
Start Date text box or click the Start Date drop-down button to choose a date on a cal-
endar. If you must schedule a project to finish on a specific date, select the Schedule
From list box and choose Project Finish Date. You can then type a specific date in the
Finish Date text box. This will move the project to schedule backward from this date.
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59Supplying Information for a New project

■ Current Date and Status Date—Microsoft Project 2003 uses the information in these
fields to perform several date-related calculations. If you leave the Status Date field set
to NA (for example, if you want to see the values in the Earned Value fields calculated
up through and including the current date or a date you specify), Project uses the date
in the Current Date field as the status date. This date is also used in the Complete
Through field in the Update Project dialog box, as well as in the placement of progress
lines in the Gantt Chart view. See the section “Changing the Current Date and Status
Date Text Boxes,” later in this chapter, for more information about when and how you
might want to use this field.

➔ For information on telling Microsoft Project 2003 that work on the current project is complete through a
specific date, see “Analyzing Progress and Revising the Schedule,” p. 555. 

■ Calendar—You can use the Calendar list box to select a different base calendar for
scheduling the project. The section “Scheduling with Calendars,” later in this chapter,
explains when you should use the default base calendar (Standard) and when you should
consider using a different calendar. 3

N O T E
If the base calendar you want to use is defined in a different project file from the one
you’re currently using, you must use the Organizer to copy that calendar into the current
project file before you can select it (see the section “Working with Calendars,” later in
this chapter).

■ Priority—When you are sharing a pool of resources across multiple projects, you can
identify which project has the highest priority by changing the Priority field in the
Project Information dialog box. You can set this project level priority between 0 and
1000 (1000 being the highest priority).

➔ When you have a resource that is assigned too much work, and they don’t have enough time in which
to do the work, then the resource is said to be overallocated, and you can have Microsoft Project 2003
attempt to resolve the problem. For more information, see “Resolving Resource Assignment Problems,”
p. 401. 

Understanding the Start and Finish Date Text Boxes

When you’re starting a new project document, you enter either a start date or a finish date
into the Project Information dialog box to function as an anchor point for scheduling the
tasks in the project. Microsoft Project 2003 computes the other date. You cannot specify
both a start date and a finish date.

If you enter the start date, Microsoft Project 2003 schedules the first task in the project to
begin at that time and calculates the project’s finish date based on that starting date and the
sequence of tasks that come after the first task. New tasks that are added begin as soon as
possible when you schedule from a start date.

If you enter the finish date, Microsoft Project 2003 schedules the tasks from the end of the
project first and works backward. The final task is scheduled to end by the finish date; the
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60 Chapter 3 Setting Up a Project Document

task that precedes the final task is scheduled to end in time for the final task to begin, and so
on. By the time Project schedules all tasks to end in time to meet the finish date require-
ment, the program has calculated a start date (that is, the date by which the first task must
begin for the project to be completed by the specified finish time). New tasks that are added
begin as late as possible when you schedule from a finish date.

You can use the Schedule From list box to change a project’s schedule as often as you like. If
you want to see when a project must start in order to finish by a deadline date, you can
change the Schedule From option to Project Finish Date and enter the deadline date. When
you choose OK, Project recalculates the schedule, including a new start date. You can then
view the Project Information dialog box again to see what the required start date is, given
the new finish date deadline. While in the Project Information dialog box, you can switch
back to scheduling from a fixed start date.

To select a start date or finish date, you can either type the date or click the drop-down but-
ton to select a date from a calendar (see Figure 3.4). To select a date in the current month,
you simply click that date. To select a date in a different month, you use the left and right
arrows to select a different month and then click the date.

3

Figure 3.4
The Project
Information dialog
box allows the selec-
tion of dates via the
pop-up calendar.

When you’re managing a project, it’s best to schedule forward based on a start date. If you schedule the pro-
ject based on a fixed finish date, all activities must flow backward based on durations, linkages, and the calen-
dars assigned; this is fine until you begin tracking the project. When you schedule from a fixed finish date, the
start date is based on the actual time needed to complete each phase. What’s wrong with this picture? Because
both the start and finish dates are fixed, the schedule cannot expand or contract.

Also, scheduling from the finish date assumes that there is no project buffer, or extra time added to the end of
the project, to allow for delays in completion of the project, unless you take that into consideration in selecting
the finish date from which to schedule backward.

When you encounter a date field, you can use the built-in pop-up calendar to select a date.

N O T E
If you change your mind about the date you selected, you can click the area designated
Today at the bottom of the calendar to immediately return to today’s date. This closes
the calendar pop-up. Of course, pressing Esc closes the window entirely, without saving
the changes you’ve made.
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61Supplying Information for a New project

Changing the Current Date and Status Date Text Boxes

The computer’s internal clock initially determines the date listed in the Current Date text
box. Changing this text box has several implications:

■ The date determines the location of the dashed (current) date line on the Gantt Chart
view time line.

■ The current date appears in the header of the Project Summary standard report as an
As Of date. You also can display the Current Date text box in headers or footers on
other reports by typing the appropriate code in the header or footer definition.

■ You can customize Project to start new tasks based on the current date instead of on the
project’s start date. You do so by selecting Tools, Options, selecting the Schedule tab,
and changing a setting next to New Tasks: Start on Project Start Date or Start on
Current Date.

The Current Date can be used for benchmarking the progress of tasks, but you can use an
alternative date for this as well. If you specify a date in the Status Date field in the Project
Information dialog box, this is the date Project uses for placing the progress lines in the
Gantt Chart view. In addition, if there is a date in the Status Date field, Project uses this
date when calculating the Earned Value fields and for tracking purposes in the Update
Project dialog box. 

To change the Current Date field or enter a date in the Status Date field, select the field and
type the date or click the drop-down arrow to select a date from a calendar pop-up.

Displaying the Project Statistics Dialog Box

You use the Statistics button at the bottom of the Project Information dialog box to display
the Project Statistics dialog box (see Figure 3.5). You can also display this dialog box by
clicking the Project Statistics button on the Tracking toolbar.

3

Figure 3.5
The Project Statistics
dialog box gives a
quick summary of the
status of a project.
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62 Chapter 3 Setting Up a Project Document

The Project Statistics dialog box displays summary information about a project. You cannot
manually change the data in this dialog box; you can only view and print it. 

3

N O T E
You can use the Project Summary report (in the Overview category) to print out the pro-
ject statistics. Reports are accessed from the View menu.

The Project Statistics dialog box shows the current, or currently scheduled, values for five
project parameters: the start date, finish date, total duration, work, and cost. If you have
saved the baseline copy of the schedule, the baseline values also are displayed, for 
comparison.

When work is actually performed on the project and progress on tasks is recorded, the
information in the Actual row is updated. The percentage complete of the duration and
work of the project are shown at the bottom of the dialog box, in the Percent Complete
section. 

To close the Project Statistics dialog box, click the Close button.

Using the Properties Dialog Box
In the Properties dialog box, you can view and edit a number of options that describe a pro-
ject. To open the Properties dialog box, choose File, Properties. The Properties dialog box
has five tabs; the Summary tab is the default.

N O T E
You can display information from the fields in the Properties dialog box—especially fields
from the Summary tab—in the header or footer area of printed views or reports for a
project. See Chapter 13, “Printing Views and Reports,” for more information.

The Summary Tab

In the Summary tab of the Properties dialog box (see Figure 3.6), you can supply descriptive
information about a project and the people associated with it. You can include the options at
the top of the tab (Title, Subject, Author, Manager, and Company) in reports as header or
footer text. The options Category, Keywords, and Comments are useful when you’re
searching through previously created project files on your hard disk. You can use the
Hyperlink Base option to indicate the main address to the hyperlinks you have in your pro-
ject. This can be a link to another file on your computer or server or a link to a location on
the Web.
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63Supplying Information for a New project

To change any of the options on the Summary tab, select its text box and type an entry.
Press the Tab key after you have finished typing the entry to move to the next option.
Except in the Comments list box, pressing the Enter key on this tab selects the OK button
and closes the dialog box.

If the newly created project originated from a template, the template name appears at the
bottom of the dialog box.

You can select the Save Preview Picture check box to have Project save a thumbnail sketch
of the current view when you save the file. You can browse these preview pictures when you
search for files by using the File, Open command. The Save Preview Picture check box is
not selected by default.

If you have trouble locating files in the future, you can use the Open dialog box to search
for words entered in the fields of the Summary tab to find the needed file.

The General Tab

The General tab of the Properties dialog box describes the file that stores the project docu-
ment. It provides statistics about the project file: the name, type, location, and size of the
file, as well as the dates when the file was created, last modified, and last opened. This tab is
blank until the document is saved as a file.

The Statistics Tab

The Statistics tab of the Properties dialog box provides useful statistics about your work
with the project document, including when it was created, last modified, last accessed, 
and last printed. It also shows who last saved the file, which is useful for shared files in a

3

Figure 3.6
The Summary tab of
the Properties dialog
box presents descrip-
tive options that are
useful in reports and
for searching for files
to open.
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64 Chapter 3 Setting Up a Project Document

workgroup. The Statistics tab also shows how many times the document has been revised
and the total amount of computer time spent editing the file.

The Contents Tab

The Contents tab of the Properties dialog box displays the most commonly reviewed statis-
tics about the current project schedule: the start and finish dates; the scheduled duration,
work, and cost; and the percentage completed for both duration and work. The Contents
tab displays summary statistics about the project schedule.

The Custom Tab

With the Custom tab of the Properties dialog box you can add additional properties to a
file. Then, you can search for files by the values of these properties. Based on the informa-
tion in Figure 3.7, for example, you could search for all projects that have Marketing in the
Department Value field. The bottom row in the Properties list box shows that a property
named Department has been created for this document, with the text value Marketing.3

Figure 3.7
The Custom tab of the
Properties dialog box
allows you to set up
custom search 
parameters. 

To create a custom property for a project, follow these steps:

1. Choose File, Properties.

2. Choose the Custom tab.

3. Type a property name in the Name list box. The drop-down list below the Name list
box lists commonly used properties. If you want to use one of these, select it.

4. Use the Type drop-down list to define the type of data to place in the field. You should
use this option only when you will type the value of the property instead of linking it to
a field in the project file. When you link the property value to a project field, the Type
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65Selecting the Environment Options

drop-down list is unavailable. The allowable data types are Text, Date, Number, and Yes
or No (logical).

5. If you chose Text, Date, or Number previously, type a value in the Value text box. If
you chose the Yes or No option in the Type list box, you see Yes and No buttons in the
Value box. Select the one you want to use.

6. Click the Add button to add the property to the list in the Properties dialog box.

If you want to link a property value to a project field, follow these steps:

1. Choose File, Properties.

2. Choose the Custom tab.

3. Type a property name in the Name list box.

4. Select the Link to Content check box (refer to Figure 3.7). The Type list box is grayed
out, and the Value text box becomes a drop-down list. The name of the text box
changes to Source.

5. In the Source drop-down list box, choose the field that has the value you want the
property to reflect.

6. Click the Add button to add the property to the list in the Properties dialog box.

If you want to delete a custom property, select it in the Properties list and click the Delete
button.

If you want to modify the value for a property, select the property name in the Properties
list. This places the current name and value in the text boxes at the top of the dialog box.
Change the Type or Value fields as needed, and the Add button automatically changes to
Modify. If you change the Name field, you have to use the Add button to include it as a new
property. You can then use the Delete button to remove the original, leaving the newly
named version. Then you can click the Modify button to complete the change.

When you finish the custom properties list, click the OK button unless you want to make
additional changes on one of the other tabs.

Selecting the Environment Options
Microsoft Project makes many assumptions regarding projects. You can review these default
settings, which control the behavior of the application, in the Options dialog box. The
options are divided into two types: global and file-specific options. To display the Options
dialog box (see Figure 3.8), choose Tools, Options. The options in this dialog box are con-
veniently organized into categories on a number of tabs.

3

05 0789730723_ch03.qxd  1/12/04  1:47 PM  Page 65



66 Chapter 3 Setting Up a Project Document

Most of the settings in the Options dialog box affect the way you view all projects, and are
referred to as global options. Changes you make to global options affect projects that have
already been created, the current project you are working on, and any future projects you
create. For example, changing the date format (which might include hours and minutes
instead of just rounding to the day) affects all projects, including those that you originally
created with a different date format. The new format remains in effect for all projects until
you change the setting again.

Some of the options in the Options dialog box are specific to the file you are currently
working with. These options include the filename in the section title. For example, the dia-
log box in Figure 3.8 shows three sections that contain file-specific options: Cross Project
Linking Options for ‘New Product,’ Currency Options for ‘New Product,’ and Outline
Options for ‘New Product.’ Changes made to these settings affect only the current project
you are working on—in this case New Product.mpp. Any options that are not part of a sec-
tion or for which the section title does not include the filename in the title (such as the
Show section in Figure 3.8) are global options.

The Cross Project Linking Options For section of the View tab controls links between pro-
jects. For example, the setting in this section in Figure 3.8 is set for the active file only—the
default is to display all external links. In addition, when you attempt to open a file that con-
tains links to other projects, a dialog box alerts you that the file has external links.

3

Figure 3.8
The View tab is the
default tab in the
Options dialog box.
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Selecting the Show Outline Number option in the View tab of the Options dialog box displays the task list of the
project in a traditional Work Breakdown Structure (WBS) outline format, tying the schedule of the project to a
previously defined scope of work. This is useful to ensure that all the necessary work of the project has been
captured.

Also, when you select the option to display a project summary task, a roll-up summary task (numbered 0)
appears at the top of the Gantt Chart view and spans the entire duration of the project you have created. Many
times, Project users create this manually by indenting, or demoting, all subsequent tasks to the first one, simply
because they are not aware of this feature.

3

N O T E
If the Office Assistant is active, the external link message appears in an Office Assistant
pop-up.

In some cases, file-specific options can be changed for the current file and new files if the
section containing the file-specific settings has a Set as Default button (see Figure 3.9). If
you click the Set as Default button, Project updates the Global template to reflect the
option settings. The Global template controls the settings for all new project files. The cur-
rent document, as well as all new project documents, incorporates these options, but previ-
ously created documents do not change.

Figure 3.9
The Edit tab of the
Options dialog box
has two sections that
include Set as Default
buttons.
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68 Chapter 3 Setting Up a Project Document

The following sections focus on a few choices in the Options dialog box that are critical in
defining any new project and a few options of general interest.

3

N O T E
All changes you make in the Options dialog box are saved in the Windows Registry.

Reviewing Critical Options
There are several important settings on the Calendar tab that you should confirm are
appropriate for your organization. These options determine how the calendar is used on
printed reports, how your fiscal year is designated, and, most importantly, how your use of
the terms day, week, and month are interpreted by Microsoft Project 2003. Figure 3.10 shows
the settings on the Calendar tab.

Figure 3.10
The Calendar tab of
the Options dialog
box enables you to
customize project
plan settings to your
organization’s 
working hours.

Defining Days, Weeks, and Months

The three most critical settings are those that define the meaning of the basic task duration
units—days, weeks, and months. The fundamental unit of time in Microsoft Project 2003 is
the minute. When you enter any other unit for a task duration, Project internally converts
these terms into minutes, based on the definitions in the Options dialog box. All calcula-
tions dealing with duration are carried out in minutes. When you ask Microsoft Project
2003 to display a task duration in days, weeks, or months, Project uses these settings to con-
vert the display. Therefore, the options Hours per Day, Hours per Week, and Days per
Month are crucial to the interpretation and display of your estimates of task duration (refer
to Figure 3.10).
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69Selecting the Environment Options

Thus, for example, if you estimate a task duration to be 2 days, Project uses the entry in the
Hours per Day text box to internally set the duration to minutes. If the Hours per Day
entry is 8.00, the duration is recorded as 960 minutes (that is, 2 days×8 hours/day×60 min-
utes/hour). If the Hours per Day entry is 10.00 and you estimate the duration to be 2 days,
then the task duration is recorded as 1,200 minutes, which is much more work than if the
Hours per Day entry is 8.00.

You need to make sure these settings are appropriate for your organization. For example, if
you work for an organization that has a 4-day work week (that is, each employee works 10
hours per day for 4 days each week), you should change the Hours per Day field to 10 and
leave the Hours per Week field at 40. If your organization normally works 8 hours per day
Monday through Friday and 1/2 day Saturday, you might prefer to change the Hours per
Week to 44 so that when you estimate a task to take a week, the duration means the same
thing to Microsoft Project 2003 as it does to you.

Note that the definition of the task duration is set at the time you estimate it, according to
the definition of the terms you use (day, week, or month). If you later change the definition
of a day, for example, to be 10 instead of 8 hours, Project does not change the minutes
defined for each task duration. However, the display of those minutes in days or weeks is
affected.

The Project Management Institute (PMI) suggests that no task be longer than 80 hours (or 2 weeks’ duration,
based on a 40-hours-per-week calendar). In other words, the work should be broken down to increments that
are no longer than this span of time.

Also, defining months can be difficult because it is typically an inconsistent measure of time, so it’s better to
use hour or week duration units.

3

C A U T I O N
If you change the definitions for a day, week, or month after you enter the project data,
Microsoft Project 2003 doesn’t redefine the minute duration of tasks; it merely displays
these minutes as a different number of days or weeks. For example, if you originally
entered the duration of a task to be 1 week (at 40 hours per week) and later changed
the number of hours in a week on the Calendar tab from 40 to 44 hours, the duration
for the task would read .91w. The task would still be 40 hours, but 1 week would now be
equal to 44 hours, not 40. This is one reason for establishing option settings before
entering task and duration information.

➔ To learn how Microsoft Project 2003 interprets duration, see “Creating a Task List,” p. 115. 

Defining the Default Start and End Time of Day

When you define the working days, hours, and months for the Standard calendar (see
“Defining a Calendar of Working Time,” later in this chapter), you define the hour when
work normally begins and ends. It’s important that you also record those standards in the
Default Start Time and Default End Time text boxes on the Calendar tab of the Options
dialog box. Microsoft Project 2003 uses these settings in several places:

05 0789730723_ch03.qxd  1/12/04  1:47 PM  Page 69



70 Chapter 3 Setting Up a Project Document

■ When you specify the date but not the time for the start or finish date of the project in
the Project Information dialog box.

■ When you put a constraint on a task, such as Finish No Later Than.

■ When you begin tracking the actual work on the project.

For example, say that the normal work hours for an organization are 7:00 a.m. to 4:00 p.m.
If you define these hours in your Standard calendar but leave the setting for Default Start
Time at 8:00 a.m., Microsoft Project 2003 schedules the first task in the project to start 1
hour later than the actual start of work.

In addition, when you use the Tracking toolbar buttons to designate the percentage com-
pleted for a task, the time a task started is assumed to be the default start time from the
Calendar tab in the Options dialog box. Even though time might not be displayed as part of
the Start Date field format, it is stored with the date. So if the Standard calendar hours are
from 7:00 a.m. to 4:00 p.m. and you mark a task as 100% complete, the actual start date
shows the task starting at 8:00 a.m. and the actual finish date shows the task ending the next
day at 8:00 a.m. If only the dates and not the time are displayed in the Start and Finish Date
fields in the Gantt Chart view, it appears that there is an error—a task with a duration of 1
day (8 hours) starts on one day but ends on the next day. The culprit is typically an inconsis-
tency between the time used on the Standard calendar and the time designated on the
Calendar tab of the Options dialog box.

3

T I P
It’s a good idea to display a date format that also displays time. The Date Format setting
is on the View tab of the Options dialog box.

If you change the default start and end times, be careful to coordinate these time settings
with the Standard calendar you create for your organization.

If you are having problems changing the default start times, see “Start Times Don’t Match” and
“Making Start and End Time Changes Permanent” in the “Troubleshooting” section near the end
of this chapter.

Defining the Start of the Fiscal Year

The name of the month that begins the fiscal year is a critical option. This choice affects
displays and reports that show annual and quarterly amounts. If the fiscal year begins in
October, for example, you might want all reports to include October through December
figures in first-quarter totals and the annual figures to be calculated by using the October
through September figures. The Fiscal Year setting is on the Calendar tab of the Options
dialog box.

By default, the fiscal year is assumed to be numbered by the year in which the fiscal year
ends. Therefore, the year in which the fiscal year ends will be used with all months in that
fiscal year. For instance, if the fiscal year begins October 2003 and ends September 2004,
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then the actual calendar month November 2003 would belong in the fiscal year that ends in
2004.

On the Calendar tab, you have the option to have the fiscal year numbering use the starting
year instead of the ending year (see Figure 3.11). If you select the Use Starting Year for FY
Numbering check box, a fiscal year running from October 2003 to September 2004 would
have the calendar month of February 2004 belong in fiscal year 2003; the second quarter of
fiscal year 2003 would be the calendar months January, February, and March 2004.

3

Figure 3.11
You can change the
Fiscal Year Starts In
option if you want to
set some month other
than January as the
beginning of the fiscal
year.

T I P
The Fiscal Year Starts In and Use Starting Year for FY Numbering settings are file-specific
settings. If you want to change these settings for all future project files as well as the
active file, click the Set as Default button near the bottom of the dialog box.

In some previous versions of Microsoft Project 2003, changing the Fiscal Year Starts In set-
ting in the Options dialog changed the display of the calendar in the timescale of the Gantt
Chart view; since Project 2000, this has not been the case. You can either retain the calen-
dar year or show the fiscal year. To choose whether to retain the calendar year or show the
fiscal year, you must access the Timescale dialog box by either choosing Format, Timescale
or right-clicking the timescale headings in the Gantt Chart view and choosing Timescale
from the shortcut menu. The Timescale dialog box appears. To display the fiscal year
instead of the calendar year, click the Use Fiscal Year check box (see Figure 3.12).
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You can display the fiscal year on either the major or minor scale of the timescale, which is
the first or second calendar displayed. A useful display would be to have the fiscal year on
one scale and the calendar year on the other scale, using the same unit for both scales.

3

Figure 3.12
The timescale head-
ings can display fiscal
years instead of 
calendar years.

N O T E
You can only change settings in the timescale of the current view. To update the
timescale in another view, such as the Task Usage or Resource Usage view, you have 
to display that view and change the Timescale settings there.

The timescale display in the Gantt Chart view uses fiscal year numbers instead of calendar
year numbers only when the timescale is formatted to display the year, not when displaying
months or days.

Setting Options in the Calendar Tab

To set critical calendar preferences, follow these steps:

1. Choose Tools, Options. The Options dialog box appears.

2. Click the Calendar tab.

3. If your fiscal year does not start in January, select the correct month from the Fiscal
Year Starts In drop-down list. The default is for the next calendar year to be the fiscal
year.

4. If your work day doesn’t start at 8:00 a.m., enter the appropriate time in the Default
Start Time text box. You can enter time in 12-hour or 24-hour format. If you use the
12-hour format, be sure to add p.m. to hours past noon (and remember that noon itself
is 12:00 p.m.).

5. Change the Hours per Day, Hours per Week, or Days per Month fields, if necessary, to
accurately represent your organization.
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6. Click the Set as Default button to make the values you entered for Fiscal Year Starts In,
Default Start Time, Default End Time, Hours per Day, Hours per Week, and Days per
Month the default values for all new project documents.

7. When you are finished, click the OK button.

3

T I P
Some organizations change the hours to reflect the hours they expect to work on the
project minus the hours needed for other activities (for example, to account for meetings
that normally happen in the course of a 40-hour work week). You might change Hours
per Day to 6h, allowing 2 hours per day for other activities. This type of change is a judg-
ment call on your part. If you change the hours in this way, make sure the Hours per
Week and Hours per Month fields are changed as well.

Companies typically split the day as 75% (for example, 6 hours/day, 30 hours/wk) productive time, or time
worked on project-related tasks, and 25% (for example, 2 hours/day, 10 hours/wk) administrative time, or time
for office-related tasks. Some companies expect a 45-hour work week in which 8 hours per day are billable
and 1 hour is set aside for administrative matters.

When you’re planning your project, it’s best to consider the specifics of how your organization operates—or
how your particular project will work.

Setting Other Useful Options
You can change other settings to make data entry easier. It is a good idea to review the cur-
rent settings in the Options dialog box for each of the following items:

■ Click the General tab to confirm that your name is in the User Name text box. Project
uses this name for the Author and Last Saved By properties of the document.

■ Click the Schedule tab to select the time unit you plan to use most often when estimat-
ing task duration (see Figure 3.13). Choose the Duration Is Entered In drop-down list
to select Minutes, Hours, Days, Weeks, or Months. The Duration setting provides
Microsoft Project 2003 with instructions about the unit of time to use if you enter a
task duration without specifying the unit of time. For example, suppose most of your
tasks will have the duration listed in days, and you have selected Days as the time unit
in the Duration Is Entered In list box. In the Gantt Chart view, if you enter a 2 in the
Duration column, Project records the task duration as 2d (that is, 2 days). Any other
duration type has to be entered manually. For example, you would enter a task with a
duration of 3 weeks as 3w.

■ Click the View tab to change the default view for new projects. If you prefer to work in
a view such as the Network Diagram view or the Task Sheet view—rather than the
Gantt Chart view—when starting a new project, change the Default View setting (see
Figure 3.14).
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3

Figure 3.13
You can set the
default time unit you
want used for display-
ing task duration.

Figure 3.14
You can set the
default view on the
View tab.

You can set the security settings for your project.

■ Click the Security tab to determine whether you want to save any existing file proper-
ties with the saved file. You can choose to remove this information (for example if you
are using an older file or a template) when you save the file. This tab also allows you to

05 0789730723_ch03.qxd  1/12/04  1:47 PM  Page 74



75Selecting the Environment Options

choose the macro security settings for how Microsoft Project 2003 should deal with
macros and add-ins. 

■ On the View tab, choose Date Format to specify how to display dates. The default for-
mat displays the date, with the day of the week. The Date Format list box provides
alternative format options (such as the date and time together or just the date).

3

T I P
You can use the Control Panel to set the international regional style for entering date and
time. To change the regional date and time formats, open the Windows Start menu and
choose Settings, Control Panel. In the Control Panel folder, choose Regional Settings to
display the Regional Settings dialog box. Choose the Date and Time tabs, and then make
your selections.

■ On the View tab, choose the Decimal Digits text box in the Currency Options Format
section to specify the number of decimal points to use in displaying money amounts.
The preset value is two decimal points, but you can change that to zero to suppress
decimal-point display. As mentioned previously, you can use the Regional Settings dia-
log box in the Control Panel to select currency units and decimal display.

■ In Microsoft Project 2003 views that contain tables (such as the Gantt Chart view), the
Enter key causes the selection to advance automatically to the cell below—for example,
when you type data in a sheet column, such as the left side of the Gantt Chart view or
the Resource Sheet view. You can turn off this feature by deselecting the Move
Selection After Enter check box on the Edit tab.

T I P
Many users enter tasks by typing the activity name, tabbing to the right to enter the
duration, and then returning to the left to enter the next task name. Because Project
won’t automatically return to the next line and requires you to select the next task name
field with the mouse or arrow keys, you might find it helpful to select the range of cells
that you are entering tasks into. When you do so, the Tab key advances the selection to
the right and then back to the left after the duration has been typed. 

■ Click the Save tab to change the default save format and path (see Figure 3.15). For
example, if you want to save all your Project files as Microsoft Project 2003 templates
or in a previous version of Microsoft Project 2003, click the Save Microsoft Office
Project 2003 Files As drop-down and choose one of the listed options. You can also
designate the default path where your Project files should be stored. The original
default is C:\My Documents. From the File Locations list box, select the file type you
want to change, and then click Modify to identify another path. However, if you are
using Project Professional in a Project Server configuration, then your projects are
saved to the Project Server database by default.

05 0789730723_ch03.qxd  1/12/04  1:47 PM  Page 75



76 Chapter 3 Setting Up a Project Document

Defining a Calendar of Working Time
Microsoft Project uses a calendar, called the base calendar, to define the default working and
nonworking days used for scheduling tasks in projects. Three base calendars are built in to
Microsoft Project 2003:

■ Standard—The 5-day, 40-hour week, with work from 8:00 a.m. to 5:00 p.m. that’s stan-
dard in the United States.

■ 24 Hour—A round-the-clock operation from 12:00 a.m. to 12:00 a.m.

■ Night Shift—An example of a calendar for those whose work shift starts toward the
end of one day and ends in the morning of the next day.

All projects are assigned to a base calendar, and the default assignment is to the Standard
base calendar. You can edit the Standard calendar, use one of the other built-in calendars, or
create additional base calendars and assign a project to one of them if you want.

The Standard calendar assumes 5 working days per week, Monday through Friday, with 8
hours of work per day (including an hour off for lunch). The default schedule is 8:00 a.m. to
12:00 p.m. and 1:00 p.m. to 5:00 p.m. No designated holidays are set in the original
Standard calendar.

You can edit the Standard calendar to reflect your organization’s regular working and non-
working days and hours. You can also designate the exceptions to the normal workdays, such
as holidays, or time periods when the organization will be closed for remodeling, a compa-
nywide meeting time when no work should be scheduled, and so on.

3

Figure 3.15
You use the Save tab
to set save options,
including the default
save location, where
to store templates,
and autosave and
database save fea-
tures.
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Base calendars are also used as the basis for resource calendars. Each resource has its own
calendar, and the resource calendar is linked to a designated base calendar (by default the
Standard calendar). The resource calendar inherits all the working days and hours of its base
calendar, as well as all the holidays and other exceptions in its base calendar. The resource
calendar can be edited to record the days and hours when the availability of the resource dif-
fers from the normal working times found in the base calendar. Examples of resource excep-
tions are vacation days, sick leave, and unusual hours on particular days.

➔ To learn more about adjusting calendars to reflect the available resources, see “Understanding Resource
Scheduling,” p. 321. 

For example, the base calendar for an organization in the United States might show that
Thanksgiving Day, the third Thursday in November, is a company holiday. Suppose a secu-
rity guard is scheduled to work on Thanksgiving Day and to have the following Friday off.
The resource calendar for this worker would initially show the company holiday,
Thanksgiving Day, as a nonworking day and the next Friday as a working day. For this secu-
rity guard only, the resource calendar needs to be edited to reverse the status of both days.

If a resource has only a few exceptions to the Standard calendar, it’s easy to edit the resource
calendar. If the resource has working times that are radically different from the standard
working times, the editing job can require a lot of work. If there are several resources with
the same unique set of working times, it’s easier to create an additional base calendar that
has those unique working times and link each unique resource to that custom base calendar.
For example, night and weekend security guards have unique days and hours. Instead of
greatly altering a number of individual resource calendars, it’s easier to create a Security
Guard base calendar to reflect the special working times for security guards. Then, you can
link each security guard to that base calendar.

Many organizations allow people to have flex-time schedules. This gives you a business reason to create several
variations of a base calendar. For example, you could configure base calendars for working hours of 6 a.m.–3
p.m., 7–4, 8–5, and so on. After you complete the calendars, you can assign them to the different resources
that use those working hours. To keep this straight in your mind, think of the Standard calendar as the hours of
operation for the business and think of the defined flex-time calendars as applying only to your resources, each
with unique hours that they work.

On the other hand, some companies schedule all tasks based on the Standard calendar, suggesting that the
task be scheduled to the day of the working calendar and not the hour of the working resource. In this case,
the company is not interested in specifically which hour the task is worked—only that it is completed on the day
that it is scheduled for completion.

It’s important to keep your organization’s work environment in mind when you are configuring base calendars
for projects.

➔ To adjust the resource calendars, see Chapter 9, “Understanding Resource Scheduling,” p. 321.

Scheduling with Calendars
Project uses the base calendar for an overall project and the resource calendars to schedule
the start dates for tasks. When Project schedules a task, it notes the earliest possible starting
date, based on when the predecessors to the task will be completed. If no resources are

3
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assigned to work on a task, the project’s base calendar is used to schedule the start and finish
of the task. Otherwise, Microsoft Project 2003 checks to see what resources are assigned to
work on the task and when the resource calendars for these resources show them being
available for work. The task is then scheduled to start on the next available working hour for
the assigned resources.

3

N O T E
The resource calendars take precedence over the project’s base calendar. In the absence
of a resource calendar, the task is scheduled using the project base calendar.

To select a base calendar, choose Project, Project Information. Click the Calendar drop-down
list and choose one of the calendars—Standard, 24 Hour, and Night Shift—from the list.

Editing the Standard Calendar
Changing the working days and hours on the Standard calendar affects the scheduled work
time for all tasks that have no resources assigned to them and for all tasks whose resources
are linked to the Standard base calendar.

Changing Working and Nonworking Days

The original Standard calendar shows all weekdays, Monday through Friday, as working days
and all Saturdays and Sundays as nonworking days. You can change the status of any day to
make the day working or nonworking, and you can specify the number of hours available for
work on any day by defining the starting and ending times for work shifts on that day.

To edit the Standard calendar, choose Tools, Change Working Time. The Change Working
Time dialog box appears (see Figure 3.16). The Change Working Time dialog box can dis-
play a calendar of working and nonworking times for any of the base calendars and resource
calendars defined for the project.

Figure 3.16
You can use the
Change Working Time
dialog box to define
the days and hours
when work can be
scheduled by
Microsoft Project
2003.
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The dialog box contains a monthly calendar form, daily working times, buttons to change
the calendar, and a legend. The legend indicates how working and nonworking days will be
displayed, along with days that have different hours from the default hours. Each date that is
modified from the default has the date underlined. If you modify a day of the week for the
entire project—for example, you make the working time on every Monday from 1 p.m. to 
5 p.m.—the letter M in the Working Time calendar is underlined and in bold. You can use
the calendar scrollbar to change months and years. The calendar spans the period from
January, 1984, to December, 2049.

To change the status of a single day or a consecutive period of days from working to non-
working or vice versa, you click the day with the mouse. You can select consecutive days by
clicking and dragging. You can select multiple days that are not consecutive by pressing the
Ctrl key as you click the extra dates. On the right side of the dialog box, there are several
options in the Set Selected Date(s) To area; you can use these options to change the working
or nonworking status of a day.

In the Set Selected Date(s) To area of the dialog box, you select the Nonworking Time
option button to make the selected day(s) nonworking. To make the selected day(s) working
days, you select the Nondefault Working Time option button.

3

T I P
To select days by using the keyboard, use the arrow keys to move to the first day you
want selected. Hold down the Shift key and use the arrow keys to select additional con-
secutive days.

You can also change the working status of any day of the week for all weeks throughout the
year. If your organization works on Saturdays, for example, you will want to make all
Saturdays working days.

To change the working status of a day for all weeks, you select the day of the week by click-
ing the day letter at the top of the calendar (for example, S for Saturday). Then, you select
the Nondefault Working Time or Nonworking Time option button in the Set Selected
Date(s) To area of the dialog box.

After the working status of a day of the week is set, that becomes the default status for that
day of the week. For example, suppose you have made every Friday, with the hours 8:00
a.m. to 12:00 p.m. (noon), a working day. If you changed a particular Friday to either a full
working day or a nonworking day and then wanted to change it back to the default hours
for Fridays, you would need to select the Use Default option button to reset the hours from
8 a.m. to 12 p.m. Selecting any specific date and the Use Default option button sets that
date’s working hours to the default for its day of the week.

Figure 3.17 shows the Change Working Time dialog box for the month of December 2003.
The company is having a holiday party on Friday, December 19. No work is likely to be
accomplished on this project in the afternoon, so this day has been marked as a partial
working day. Because the company gives all its employees the afternoon of December 24 
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as well as all of December 25 and 26 to celebrate Christmas, these days are marked as non-
working days. Partial working days are marked with slash marks; full nonworking days are
marked in gray.

3

Figure 3.17
You use the Change
Working Time dialog
box to define the days
and hours when work
can be scheduled by
Microsoft Project
2003.

Changing the Standard Working Hours

You can define the work periods for each day by supplying up to five work periods in the
From and To text boxes of the Change Working Time dialog box. The default 8-hour work
time periods each day are 8:00 a.m. to 12:00 p.m. and 1:00 p.m. to 5:00 p.m. 

Most of the time only the first four boxes (under From: and To:) are used. The remaining
six boxes are typically filled in when the working times go across midnight, to account for
several breaks or meal times, or for some other unusual work schedule. The section
“Creating a New Calendar,” later in this chapter provides a good example of using the six
time boxes.

To change the working hours in the Change Working Times dialog box, follow these steps:

1. Select the From text box for the first time period you want to change.

T I P
You can use Alt+F to select the first From text box, and then use the Tab key to advance
to the other time boxes. You can use Shift+Tab to return to previous boxes.

2. Enter a time. For acceptable time formats, see the next section, “Entering Time
Formats.”

3. Select the To text box and enter a time.

4. Repeat this process, by clicking (or using the Tab key) on each subsequent From and
To text box, to change the time in that box.
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5. To stay in the Change Working Time dialog box, simply click any day in the calendar.
Otherwise, click OK.

3

N O T E
Project checks all time entries for consistency. Each successive time must be later in the
day than the time in the preceding time text box.

You cannot leave a work period blank and put data in a work period beneath it.
Therefore, you must use the top pair of From and To text boxes first; then you can fill in
the next pair.

Entering Time Formats

You can use several formats for entering times in the text boxes of the Change Working
Time dialog box. You can use either the 12-hour clock or the 24-hour clock to enter times.
If you enter times based on the 12-hour clock, make sure that you use the a.m. and p.m.
suffixes to ensure that the program understands your intent. If you enter a time without
using an a.m. or p.m. suffix, Project uses the first instance of the time following 8:00 a.m.
(or whatever time you designate as the Default Start Time on the Calendar tab of the
Options dialog box).

For example, if you enter 3:30 without a suffix, Project assumes that you want to use 3:30 in
the afternoon and attaches the p.m. suffix. If you wanted to set a work shift to start at 5:00
in the morning, you would need to enter 5 am instead of 5:00 because the program inter-
prets 5:00 to mean 5:00 p.m. (If the time you want to enter is on the hour, you can simply
enter the hour number.)

N O T E
You enter noon as 12:00 pm and midnight as 12:00 am.

Clearing the Working Hours Text Boxes

To remove a work period from the working hours text boxes in the Change Working Time
dialog box, you need to delete both the From time and the To time for that period. To do
so, follow these steps:

1. Select the From text box for the work period you want to remove.

2. Press the Delete key to clear the text box.

3. Move to the To text box and select the time entry. Press Delete to remove that time
period.

Resetting a Calendar

You can select the Use Default option button in the Set Selected Date(s) To area of the
Change Working Time dialog box to cancel changes you have made for calendar days.
Selecting individual days and choosing Use Default returns those days to the original 
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working hours for those days of the week (as defined in the base calendar). Selecting the day
of the week letters at the top of the calendar and choosing Use Default returns all days in
the selected column to the standard 8-hour day, 8 a.m. to 5 p.m. (or whatever timeframes
you have designated for the calendar). Selecting all the weekday letters at the top of the cal-
endar and choosing Use Default returns the working hours—as well as any other excep-
tions—back to the default of the currently selected calendar. A warning message appears,
indicating that the calendar will be reset to the original settings.

Creating a New Calendar
Suppose you have a processing crew that works from 5:00 p.m. to 2:00 a.m., Monday
through Friday. You can create a Processing Crew calendar to use as a base calendar for the
resources in that group. On this calendar, the regular shift begins at 5:00 p.m. and continues
to 2:00 a.m. the following day. An hour break is scheduled from 9:00 p.m. to 10:00 p.m. 

Say that on Monday the crew starts at 5 p.m., breaks for dinner at 9 p.m., comes back to work
at 10 p.m., and finishes the day at 12 a.m. (midnight). The work from midnight to 2 a.m. is
entered on Tuesday. Tuesday through Friday the working times would show 12 a.m. to 2 a.m.,
then 5 p.m. to 9 p.m., and 10 p.m. to 12 a.m. Saturday would reflect the last hours (12 a.m. to
2 a.m.) of Friday night’s shift. (Figure 3.21, later in this chapter, illustrates this example.)

You can create a new base calendar for this group by following these steps:

1. Click the New button at the bottom of the Change Working Time dialog box to create a
new base calendar. The Create New Base Calendar dialog box appears (see Figure 3.18).

3

Figure 3.18
You can start a new
calendar from scratch
or you can use a copy
of any existing base
calendar.

2. In the Name text box, type a distinctive name, such as Processing Crew, for the new
calendar.

3. Select the Create New Base Calendar option button if you want to start with no holi-
days and the standard 40-hour week. Or Choose the Make a Copy of…Calendar option
button to start with a copy of an existing base calendar and all its holidays and excep-
tions. Then select an existing base calendar from the drop-down list. If you have
already defined all regular company holidays on the Standard calendar, you should start
with a copy of it so you don’t have to enter those holidays again.

4. Click OK to start defining the new calendar. If you made changes in another calendar
that you haven’t saved, you see the warning shown in Figure 3.19 before you can pro-
ceed to make changes in the new calendar. Click the Yes button to save the changes you
made in the other calendar. The new calendar name then appears in the For list box in
the Change Working Time dialog box.
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5. To change the hours for a weekday such as Monday, select the letter at the top of the
day column and enter the shift hours for that day in the From and To text boxes (see
Figure 3.20). The hours for Mondays are 5:00 p.m. to 9:00 p.m. and 10:00 p.m. to
12:00 a.m. The remainder of the shift appears in the From and To boxes for Tuesdays.

3

Figure 3.19
You must save or dis-
card earlier, unsaved
changes in another
calendar before you
can start working on
a new calendar.

Figure 3.20
You can select the day
letter at the top of a
day column to change
the hours for that day
for every week.

6. To change the hours for several days that have identical hours, drag from the letter for
the first day to the last day in the group and enter the common hours in the text fields
on the right side of the dialog box. The Tuesday through Friday schedules require
three shifts, as shown in Figure 3.21. The first shift is the continuation of the previous
evening’s shift. The second and third shifts show the periods for the beginnings of the
next evenings’ shifts.

7. To set hours for a day that is currently a nonworking day, you must first make the day a
working day. Then you can enter the hours in the From and To text boxes. The
Saturday hours in the Processing Crew calendar are just from midnight to 2:00 a.m.
(see Figure 3.22). Select the S at the top of the Saturday column and choose the
Nondefault Working Time option to make it a working day. Then you can enter the
hours in the From and To text boxes.
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Saving or Canceling Calendar Changes
To finish editing base calendars and save the changes you have made, click the OK button at
the bottom of the Change Working Time dialog box. When you save the calendar, all the cal-
endar information is saved along with the task and resource information in the project docu-
ment. Clicking the Cancel button causes Project to ignore all the changes you have made.

Working with Calendars
If you create a base calendar in one project and want to use the same base calendar in future
projects, you can use the Organizer to copy the calendar to the Global template
(GLOBAL.MPT). The calendars in the GLOBAL.MPT file are automatically included in any new
project file. You can also use the Organizer to copy a calendar to another existing project
file, to delete a calendar from the active file, and to rename a calendar in the active file. The
following section describes how to access the New Project Wizard and how to use it.

3

Figure 3.21
You can select several
days by highlighting
the letters for the
days at the top of 
calendar display. 

Figure 3.22
You must make a day
a working day before
you can define work-
ing times for it.
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➔ In an environment where Project Server is being used, all the default calendars are held in the
Enterprise Global and are automatically applied whenever a new project is created. We are really only
considering Project Standard in this chapter, but for details of the Enterprise Project Management
Solution (referred to as EPM), please refer to “Using Enterprise Global Settings,” p. 978. 

Using the New Project Wizard

A great feature of Microsoft Project 2003 is the New Project Wizard, which steps you
through the process of creating a new project plan. It also enforces the correct use of
Enterprise custom fields, encourages collaboration, and provides opportunities to attach
supporting documentation to a project.

There are two ways to access the wizard:

■ By selecting Define a Project from the Goal-Based User Interface

■ By selecting File, New and then selecting New Blank Project from the wizard 
dialog box

3

N O T E
The GLOBAL.MPT file is stored in the directory with the Microsoft Project 2003 program
files, which is usually C:\Program Files\Microsoft Office\Office11\1033.

N O T E
If the Goal Based User Interface is not on, the New from Wizard option does not appear
in the sidepane.

The following steps describe the dialog boxes that take you through the wizard:

1. General information—You are asked to enter a start date for the project you are creat-
ing, unless the project is set to be scheduled backward from a finish date, in which case
you are asked if you are sure that you want to schedule the project from a finish date,
since the default is to schedule from the start. If there is required project information, a
link to the Project Information dialog will appear, and in it you can populate the
Enterprise Custom fields needed by your organization. No other information in this
dialog box can be edited.

2. Collaborate on your project—This step is only displayed if you are using Project
Professional and Project Server. This step offers the opportunity to connect to the
Microsoft Project 2003 Server for collaboration with project resources. If you have
already accessed the Microsoft Project 2003 Server, the Yes radio button is selected by
default, and connection information to the Microsoft Project 2003 Server is populated;
otherwise, the No radio button is selected. If you select Yes but have not used the
server before, a link to the Set Connection dialog box will be displayed. If you select to
change the server connection, the link Change Connection Information is displayed. 
If you select No, information on how to set up Microsoft Project 2003 Server later is
displayed.

05 0789730723_ch03.qxd  1/12/04  1:47 PM  Page 85



86 Chapter 3 Setting Up a Project Document

3. Save your project—Your project must be saved at this point before you proceed. If you
are using Project Server, a dialog box appears, advising that your file will automatically
register with the Project Server anytime you save information.

4. Add documents that relate to your project—This step in the wizard takes you to the
SharePoint document library, where you can upload documents that are pertinent to
your project plan, such as a project charter, a scope statement, feasibility analysis docu-
ments, budgeting documents, and change management requirements information.

5. Enter additional information—At this point in the wizard, you are directed to the link
Save and Finish, which causes you to exit the wizard and allows you to continue to fol-
low the steps within the sidepane to start entering tasks in the project.

You can programmatically modify the New Project Wizard to enforce the best practices in
attaching required documents, which might include many of the ones described in step 4.

Using the New Calendar Wizard

The New Calendar Wizard gives you a single, convenient place to set up calendars and
options that affect a project (see Figure 3.23).

3

Figure 3.23
The New Calendar
Wizard steps you
through the process
of defining the work-
ing times for a 
project.

You access this wizard via the Goal-Based User Interface by selecting Tasks and then select-
ing Define Project’s General Working Hours. When you run the wizard, you work a series
of steps. The following steps describe the dialog boxes that appear in sequence:

1. Define the project’s general working hours—This step draws a graphical represen-
tation for the working time to the right, defined by the template that you’ve selected.
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The drop-down list for templates includes all base calendars defined within the global
file. If no template is selected, a standard working calendar of 8 a.m. to 5 p.m. Monday
through Friday is displayed.

2. Define the work week—You need to define the working days of the project. You have
the option to accept the current default working hours or to define new working hours.
If you select the radio button to adjust the working hours, the sidepane displays a drop-
down list from which you can select the day you want to change. There are two sets of
fields for editing the working time, known as shifts. If you want to show and edit more
shift times, click the link Specify Additional Shifts. You can then select to apply the new
working time to all working days or select a new day from the drop-down list. You can
also select to make the new hours a default in all project files by selecting Set as
Default. Your changes are saved before you proceed.

3. Define exceptions—If you want to define exceptions to the calendar, such as company
holidays (and have Project schedule over these nonworking times), click the link
Change Working Time, and the Change Working Time dialog appears. The sidepane
provides detailed descriptions on how to make exceptions. Again, your changes are
saved before you proceed to the next step.

4. Define time units—In this step, you define how many hours will equal a day, along
with how many days will equal a week and a month. These units are synchronized with
those that are defined on the Calendar tab of the Options dialog box, which you access
via the Tools menu. Your settings are again saved before you proceed.

5. Set the project calendar—This step informs you that you have just set the calendar
that affects all the resources utilized within the project. If you need to set up additional
calendars for resource groups, you can click the – link. Otherwise, you can save and exit
the wizard. If you select the Define Working Times for Resources link, you are taken
through the following steps as well.

6. Define additional calendars—You are asked whether you would like to create a new
calendar or edit an existing one. If you select New, you need to name the new calendar
you are creating. You can also choose Edit and then click Next to choose from a list of
available base calendars.

7. Define general working hours—This process is very similar to the process in step 1,
where you define the project’s general working hours. However, in this case, you are
setting the working hours for a new calendar or for one you have chosen to edit.

8. Define the work week—This is the same process as outlined in step 2, where you
define the work week.

9. Define exceptions for specific dates—This step is the same process as outlined in
step 3, where you define exceptions to the calendar.

10. The additional calendar is set—The calendar is now set. Click Finish to save and exit
the wizard.

3
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Using the Define Working Times for Resources Wizard

Project provides the Define Working Times for Resources Wizard for setting resource cal-
endars. You access this wizard by clicking Resources from the Project Guide toolbar and
then selecting Resource Calendars. You are then walked through how to set resource calen-
dars by proceeding through a series of steps. The following steps describe the dialog boxes
in the wizard:

1. Specify working hours for individual resources—A Resource Sheet view is displayed,
with the Calendar field displayed so you can review what calendar your resources are
already set up to use. You can then click the link Define Additional Calendars if you
need to define a calendar for a group of resources who have working times that are dif-
ferent from the project base calendar. If you want to change working time for one
resource at a time instead of for a group of resources, select one resource name at a
time and continue through the steps of the wizard.

2. Define general working hours—Follow the same process as defined in step 1.

3. Define the work week—Follow the same process as defined in step 1.

4. Define exceptions for specific dates—Follow the same process as defined in step 1.

5. The resource calendar is set—You can choose to save and exit the wizard or to loop
back through to work with additional resources that need calendar changes.

Working with the Organizer

You can use the Organizer to copy items (such as calendars) from one project or template to
another. You can also use the Organizer to delete or rename a calendar. If you copy a calen-
dar to the GLOBAL.MPT file, the calendar becomes part of all newly created project docu-
ments. For example, to customize the Standard calendar for all new projects, you follow
these basic steps:

1. Choose Tools, Change Working Times to edit the Standard calendar in an active pro-
ject document. Define special working times, holidays, and hours in the Standard calen-
dar, as described in the section “Editing the Standard Calendar,” earlier in this chapter.

2. Use the Organizer to copy the customized Standard calendar to the GLOBAL.MPT file,
replacing the existing Standard calendar in the GLOBAL.MPT file. The Standard calendar
for all new projects will then have the customized features. See the section “Copying
Calendars to the Global Template,” later in this chapter.

You can use the Organizer to manage not only calendars but also other customized items
(such as views, reports, macros, forms, tables, filters, toolbars, and menu bars). Therefore,
you can activate the Organizer from several points in Project. Probably the most convenient
way to access the Organizer is by choosing Tools, Organizer.

3
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Copying Calendars to the Global Template
You can access the Organizer through the Tools menu. The active file—that is, the file that
contains the calendar—is referred to as the source file. The file in which you would like to
place a copy of the calendar is referred to as the target file.

Follow these steps to copy a calendar to the GLOBAL.MPT file:

1. Choose Tools, Organizer to display the Organizer.

2. Choose the Calendars tab (see Figure 3.24). The calendars in the active file are listed on
the right side of this tab. The calendars in the GLOBAL.MPT file are listed on the left.

3

N O T E
You can also access the Organizer through several other dialog boxes, such as those you
access by choosing the following options:

■ View, More Views, Organizer

■ View, Table, More Tables, Organizer

■ Project, Filter For, More Filters, Organizer

■ Project, Group By, More Groups, Organizer

Figure 3.24
You can use the
Organizer to make
customized calendars
available for use in
other projects you are
working on.

3. Choose the calendar you want to copy from the list of calendars in the source file on
the right side of the dialog box.

4. Click the Copy button. If there is a calendar in the target file that has the same name as
the source file you’ve selected (for example, the Standard calendar), Project asks for
confirmation to override the former calendar (see Figure 3.25).

Figure 3.25
You must confirm that
you want to replace
the Standard calendar
in the GLOBAL.MPT
file with the Standard
calendar from the
source file.
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5. Click the Yes button to replace the calendar in the target file with the new calendar
from your active file. Or click the Rename button to copy the calendar to the target file
by using a name that is not being used by another calendar.

6. Click the Close button to exit the Organizer.

3

N O T E
You cannot directly edit the calendars in the GLOBAL.MPT file. To edit a calendar in the
GLOBAL.MPT file, copy it to a project file by using the Organizer. Edit the calendar in the
project file, and then use the Organizer to copy it back to the GLOBAL.MPT file.

Copying a Calendar from One Project to Another
You also use the Organizer to copy a calendar from one project document to another. For
example, if you want to place a copy of the Processing Crew calendar from the Building
Construction file in the Business Case Construction file, follow these steps:

1. Open both the source and target files.

2. Choose Tools, Organizer to display the Organizer dialog box.

3. Choose the Calendars tab. The calendars in the active file (for example, Building
Construction in Figure 3.26), are listed on the right. The calendars in the GLOBAL.MPT
file are listed on the left.

Figure 3.26
You can display the
target and the source
files in the Organizer
dialog box.

N O T E
The source file does not always have to appear on the right. You can copy from right to
left or left to right. When you select the item you want to use as the source, the Copy
button’s arrow changes direction accordingly.

4. Use the Calendars Available In drop-down list box on the bottom-left side to choose
the target file. Figure 3.26 shows the Business Case Construction project as the target.

5. Choose the calendar you want to copy from the list of calendars in the source file.
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6. Click the Copy button. If there is a calendar with the same name in the target file, such
as the Standard calendar, Project asks you for confirmation to override the former cal-
endar.

7. Click the Yes button to replace the calendar in the target file with the new calendar
from your active file. Or click the Rename button to copy the calendar to the target file
by using a name that is not already being used by a calendar in the target file.

8. Click the Close button to exit the Organizer.

➔ You can also use the Organizer to share items you customize with other project files (such as views,
reports, and tables). For more information, see Chapter 21, “Customizing Views, Tables, Fields, Filters,
and Groups,” p. 833.

Printing the Base Calendars

You can print a report to show the details of each of the base calendars in the active project
file. Printing reports is covered in detail in Chapter 13 and Chapter 22, “Using and
Customizing the Standard Reports.” This section is a quick reference on how to print the
Working Days report, a report that provides information about the working and nonwork-
ing days in all your base calendars.

To print the Working Days report, follow these steps:

1. Choose View, Reports. The Reports dialog box appears, as shown in Figure 3.27.

3

Figure 3.27
The Reports dialog
box organizes reports
into five standard cat-
egories plus a Custom
option for customiz-
ing reports.

2. Choose the Overview category by double-clicking the Overview icon or by selecting
the icon and then clicking the Select button. The Overview Reports dialog box appears
(see Figure 3.28).

3. Click the Working Days report. Click the Select button to preview the report or simply
double-click the Working Days report (see Figure 3.29).

4. Click the Print button to access the Print dialog box and send the report to your
printer. 

5. Click Close to return to the project workspace.
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The report shows the standard working hours for each day of the week, followed by a list of
the exceptions for individual days. Each base calendar prints on a separate page. Figure 3.30
is an illustration of the report for the Processing Crew base calendar. Holidays are listed as
exceptions below the standard days and hours.

3

Figure 3.28
The Working Days
report prints all calen-
dars for the active
project.

Figure 3.29
The Print Preview
screen shows the lay-
out of the Working
Days report.
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Troubleshooting
Start Times Don’t Match

I’ve changed my default start time to be 7:00 a.m. and coordinated this change with my Standard
calendar, but my first task is still starting at 8:00 a.m. What’s wrong?

If you choose Project, Project Information, you’ll notice that the project starts at 8:00 a.m.
This start time occurs because when you initially entered the project start date (in the
Project Information dialog box) or accepted the default time, Project also assumed that this
was the start time. The work time for the project was set to the hours of 8:00 a.m. to 5:00
p.m. You later made changes to the Calendar tab of the Options dialog box, but changes in
this dialog box are not retroactive; you also have to change the start time for the project in
the Project Information dialog box. This is one reason you should format all dates to display
the time (through the Options dialog box). You can enter a date and time in the Start Date
field of the Project Information dialog box, even though time is not set to display in that
field. Choose Project, Project Information to recalculate the project start time.

Making Start and End Time Changes Permanent

I’ve changed my default start and end times, but when I create a new project, the times revert to the
default (8:00 a.m. to 5:00 p.m.). How can I make this change permanent?

There are two types of environmental options in the Options dialog box: file-specific
options and global options. Start and end times are file-specific options. However, if you
click the Set as Default button on the Calendar tab of the Options dialog box (where you set
the start and end times), your custom start and end times become the default for any new

Figure 3.30
The Working Days
report for the
Processing Crew base
calendar shows the
standard working
times plus the 
exceptions (such as
holidays).
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files you create. The setting is changed for the current project file as well as any new files
you create. Any existing project files are not changed, however, and need to be adjusted as
explained previously.
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